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Manual Introductorio al Análisis de Redes Sociales 

 
 
 
Introducción 
 

El análisis de redes sociales es una herramienta que nos permite conocer las 
interacciones entre cualquier clase de individuos partiendo de datos de tipo cualitativo 
más que cuantitativo. 

 
Debido a que el análisis de redes sociales requiere información de tipo cualitativa 

gracias a su propia naturaleza, se hace necesario seguir una serie de técnicas que nos 
permitan ordenar las interacciones (información) de los individuos de tal modo que dichas 
interacciones puedan ser representadas en un grafo o red.  

 
Así, las redes o grafos se constituyen como la herramienta principal para representar 

las interacciones entre individuos o grupos de individuos de forma ilustrativa y amigable.  
 
No obstante, el simple hecho de graficar las interacciones de un grupo de individuos 

no siempre es suficiente para establecer un análisis a profundidad de cada individuo 
dentro de una red y del grafo en general.  

 
Sin embargo, las características únicas del análisis de redes sociales hacen que las 

herramientas estadísticas usuales no sean del todo adecuadas para el análisis y 
razonamiento de las mismas. 

 
De esta manera, diversos investigadores de diferentes partes del mundo han 

desarrollado instrumentos matemáticos específicos para el análisis de las redes sociales, 
dichas herramientas permiten generar los indicadores capaces de explicar la estructura de 
una red tanto en su conjunto como individualmente. 

 
La estructura de una red puede analizarse con diversos indicadores, esto dependerá 

de los resultados que el analista desee obtener. 
 
Los indicadores de centralidad nos permiten analizar la red tanto en su conjunto como 

individualmente arrojando diversos resultados: grado de conectividad de la red, individuos 
con el mayor y el menor número de interacciones, intermediación de algunos actores en 
las relaciones entre individuos y la cercanía entre los individuos a través de sus 
interacciones.      

 
El presente manual intentará explicar de la manera más sencilla el uso apropiado de 

la información relacional utilizando ejemplos de diversos grupos de individuos a través de 
las herramientas computacionales, analíticas y gráficas adecuadas para llevar las 
interacciones entre individuos a un nivel de análisis que permitirá interpretar  la 
importancia de la red, de sus actores y de sus interacciones por medio de algunos de los 
principales indicadores de centralidad en el análisis de redes sociales.   
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Manual Introductorio al Análisis de Redes Sociales 

 
 
Objetivos 
 
 

1. Conocer el significado y los componentes de una Red. 

 

2. Operar con matrices en la plataforma de UCINET 6.85. 

 

3. Graficar las matrices con NETDRAW 1.48. 

 

4. Agregar atributos individuales a los actores de una Red. 

 

5. Generar e interpretar cinco Indicadores de Centralidad. 

 

6. Generar Redes y Atributos múltiples. 
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Definición de Red 
 
Cuando se habla de una Red, se entiende como un grupo de individuos que, en forma 

agrupada o individual, se relacionan con otros con un fin específico, caracterizado por la 
existencia de flujos de información. Las redes pueden tener muchos o pocos actores y 
una o más clases de relaciones entre pares de actores. Una Red se compone, por tanto, 
de tres elementos básicos los cuales son: nodos o actores, vínculos o relaciones y, flujos. 

 
Elementos básicos de una Red 

 
Nodos o actores. Son las personas o grupos de personas que se encuentran en 

torno a un objetivo común. Por ejemplo, en la Figura 1 tenemos a un grupo de amigos 
donde cada uno de ellos constituye un nodo. Usualmente los nodos o actores se 
representan por círculos. La suma de todos los nodos representa el tamaño de la Red.  

 
Vínculo. Son los lazos que existen entre dos o más nodos. En una Red de amistad, 

por ejemplo, un actor muestra un vínculo directo con otro actor. Los vínculos o relaciones 
se representan con líneas. 

 
Flujo. Indica la dirección del vínculo. Tomando el ejemplo de nuestra Red de amistad 

(Figura 1), Gil dice tener amistad con Karla pero Karla no dice tener amistad con Gil (flujo 
dirigido o unidireccional). Los flujos se representan por una flecha que indica el sentido. 
Es posible que también existan flujos mutuos o bidireccionales, como el caso en que 
Kiko referencia a Beto como su amigo y viceversa. Cuando un actor no tiene ningún tipo 
de flujo, lo que a su vez implica ningún vínculo, se dice que este nodo está suelto dentro 
de la Red. 
 

 

Nodo 
Nodos 
sueltos 

Vínculo 

Flujo unidireccional 

Tamaño: 11 actores o nodos Flujo bidireccional

Figura 1. Elementos básicos de una Red de amistad 
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Ya que tenemos una breve explicación de los componentes de una Red gráfica, 
continuaremos con el uso de Ucinet 6.851 y Netdraw 1.482 que nos serán de gran ayuda 
para realizar el análisis y la visualización de nuestros ejemplos.  
 
Plataforma del software Ucinet 6.85 

 
La representación de las interacciones entre los diferentes actores de una Red, se 

hace por medio de gráficos como el anterior, los cuales resultan más entendibles y dan un 
ambiente más amigable a su interpretación; pero cada gráfico proviene de una matriz3, en 
la cual se ha capturado previamente la información de la que se dispone. 

 
Para poder generar una matriz con la finalidad de analizar los datos y poderlos 

graficar, recurriremos a un programa llamado Ucinet, del cual se puede obtener una 
versión de prueba en la página: http://www.analytictech.com/downloaduc6.htm, una vez 
instalado el programa, podremos iniciarlo siguiendo la ruta: Inicio>Programas>Ucinet 
6>Ucinet 6 for Windows y, en la pantalla de inicio del programa observaremos lo 
siguiente: 
 

 
Figura 2. Pantalla de inicio de Ucinet 6.85 

 
Ucinet, es un programa que presenta características similares a otros programas que 

funcionan bajo el sistema operativo de Windows. En la Figura 2 se puede observar que en 
la parte superior existe una barra de menús desplegables (File, Data, Transform, Tools, 
Network, Draw, Options y Help), inmediatamente siguen una serie de iconos de acceso 
directo, y por último en la parte inferior se encuentra una barra de direcciones la que nos 
indica el directorio en que se está trabajando y donde automáticamente se van a guardar 
todos los archivos que se generen. 

                                                 
1 Borgatti, S. P., Everett, M. G. and Freeman, L. C. 2002. Ucinet for Windows: Software for Social Network Analysis. 
Harvard, MA: Analytic Technologies. 
2 Borgatti, S. P. 2002. NetDraw: Graph Visualization Software. Harvard: Analytic Technologies 
3 Conjunto cuadrado de elementos dispuestos en líneas horizontales (filas) y verticales (columnas). 
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Para crear la matriz, en donde se introduce la información, presionamos el segundo 

icono de izquierda a derecha, el cual se refiere a la función de hoja de captura, 
(Spreadsheet en inglés)  A, al hacerlo nos aparecerá una pantalla como la 
mostrada en la  B, una vez que aparezca podremos empezar a introducir los 
datos en la matriz. 

Figura 3
Figura 3

Figura 3. Spreadsheet (hoja de captura) (A) y página de captura de la matriz (B) 

 
 

A) B) 

 
Una vez abierta esta ventana (Figura 3 B) y para poder generar nuestra matriz, 

primero comenzaremos a identificar las herramientas esenciales que ésta contiene 
(Figura 4). 

 
Del lado derecho de la , ampliada en la Figura 5, se puede apreciar la “Celda 

actual (Current cell)”, las “Dimensiones de la matriz (Dimensions)” y el “modo (mode)” de 
la matriz (Normal o Simétrica) (Normal/Symmetric). El primero, indica en qué celda nos 
encontramos introduciendo datos; el segundo, el número de filas y columnas con la que 
está conformada nuestra matriz, en nuestro caso pondremos tanto en Rows: (filas) y 
Cols: (columnas) el valor de 11, ya que este es el tamaño de la Red del ejemplo con el 
que comenzaremos a trabajar; es decir, el número de actores con los que practicaremos 
(Figura 1).  

Figura 4

 

Medidas de Centralidad 5



Manual Introductorio al Análisis de Redes Sociales 

 
Figura 4. Identificación de herramientas esenciales de la matriz 

 
Antes de continuar, es importante señalar que el valor que utilicemos tanto en filas 

como en columnas deberá ser idéntico; esto es, que construiremos una matriz 
cuadrada4. 

 
De la misma manera, en nuestro ejemplo nuestra matriz no sólo será cuadrada, sino 

que también será una matriz idéntica5 ya que introduciremos el mismo nombre de actor 
tanto en la columna como en la fila. 

 
Por último, el modo de la matriz responde al tipo de flujos que se dan entre los 

vínculos de los nodos, cuando hablamos de una matriz normal se tienen tanto Flujos 
unidireccionales como bidireccionales dentro de la Red; y cuando tenemos una matriz 
simétrica6, sólo se dan flujos bidireccionales. 
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Figura 5. Herramientas esenciales para la creación de la matriz de información 

 
 

Introducción de datos a una matriz de Ucinet 
 
Antes de comenzar a introducir los datos en la matriz, revisaremos las relaciones que 

cada actor dice tener con los demás nodos, el Cuadro1 nos proporciona de una manera 
sencilla las relaciones de amistad que dijeron tener los actores o nodos entre ellos. 

 
Cuadro 1. Resultados de las relaciones de amistad entre los actores 

Nombre Tiene amistad con 
Alex Gil, Rox y Pao 
Gil Alex, Karla y Kiko 
Rox Alex, Beto y Kiko 
Beto Alex, Gil y Kiko 
Vero Nadie 
Pao Nadie 
Karla Nadie 
Prisci Nadie 
Armando Nadie 
Alexa Alex, Gil y Kiko 
Kiko Alex, Gil, Beto,  
 
Las relaciones del Cuadro 1 las introduciremos en nuestra matriz, esta debe tener 

una característica importante, ser idéntica; es decir, las filas y las columnas deberán ser 
iguales, por lo tanto, capturaremos los nombres de nuestros actores tanto en las 
columnas como en las filas siguiendo el mismo orden (Figura 8).  

 
Para facilitar este procedimiento y evitar errores en el momento de capturar los 

nombres de los nodos o actores, podemos introducir todos los nombres en la primer 
columna (Figura 6) y después seguir esta ruta: Labels>Copy rows to columns ( ), Figura 7
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de esta manera los títulos de las filas automáticamente serán los títulos de las columnas 
(Figura 8).  

 

 
Figura 6. Introducción de los títulos de las filas en la primer columna 

 

 
Figura 7. Copiado de los títulos de las filas hacía los títulos de las columnas 
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Figura 8. Captura de nodos en una matriz 

 
Ya que hemos capturado el nombre de cada nodo, podremos comenzar a introducir 

las relaciones entre los actores; en este caso, daremos el valor de “1” a la existencia de 
relación y “0” a la ausencia de ella. Es importante aclarar que no es posible dar el valor de 
“1” en la celda que pertenece al mismo nodo, es decir, por ningún motivo7 debemos dar 
valor mayor que “0” a Alex con Alex, Gil con Gil, etc. De igual forma, no debemos dar 
valores mayores a “1”. Hay que aclarar que en algunas ocasiones sí se pueden utilizar 
valores mayores a “1” pero sólo cuando se trabaja con redes ponderadas, en este caso 
sólo se utilizaran valores de “·0” y “1” . 

 
De esta manera, para facilitar la captura de los datos y evitar errores, pondremos el 

valor de “0” a las celdas que pertenecen al mismo nodo ( ). Figura 9

Figura 9. Evitando errores en la captura de datos de la matriz 

 

 

                                                 
7 Es posible utilizar un valor mayor que “0” y de “1” en estas celdas cuando el análisis así lo requiera, en nuestro caso, los 
ejemplos con los que trabajaremos en este manual no necesitan tener un valor diferente a “0”.  
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Ya que hemos preparado nuestra matriz evitando errores de captura, comenzaremos 

con la lectura del cuadro anterior (Cuadro 1), por ejemplo, tenemos que Alex dice tener 
relación con Gil, Rox y Pao, de esta manera, comenzaremos a dar el valor de “1” a estas 
relaciones de la siguiente manera (Figura 10): 

 

 
Figura 10. Captura de las primeras relaciones en la matriz 

 
Podemos observar que la captura de las primeras relaciones se realizó en la fila de 

Alex, ya que este nodo es el primero que observamos, es importante recordar que la 
captura de todos los datos deberá hacerse de fila a columna y ser de la misma forma; es 
decir, en cada fila capturaremos las relaciones que el nodo dice tener con los demás 
actores (columnas), nunca podrá ser de otra manera. 

 
Teniendo claro la forma en que se deben de capturar las relaciones, proseguiremos a 

realizar el mismo procedimiento para cada actor, . Figura 11
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Figura 11. Captura de todas las relaciones en la matriz 

Figura 
11

 
Ya que tenemos capturadas todas las relaciones encontradas en esta Red de 

amistad, nos permitiremos dar una pequeña interpretación con respecto a las filas y las 
columnas: 

 
Como ya habíamos mencionado anteriormente, las filas representan las relaciones 

que cada actor dice tener con los demás nodos, por otro lado, las columnas son todas las 
relaciones que otros nodos dicen tener con un actor; así, podemos observar en la 

 que Gil dice tener relaciones de amistad con tres actores y, cuatro actores dicen tener 
relación con Gil, por mencionar un ejemplo. 

 
Ahora, después de esta breve interpretación del significado de las columnas y las filas, 

procederemos a “llenar” con el valor de “0” a las celdas con ausencia de relación. Para 
realizar este procedimiento de una manera rápida y sencilla, presionaremos el ícono “Fill” 
que se encuentra en la cuarta posición contando de derecha a izquierda ( ). Figura 12
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Figura 12. Llenado de los espacios en blanco con la herramienta “Fill” 

 
Ya que tenemos nuestra matriz completa, procederemos a guardarla con los 

siguientes pasos: Presionaremos File (en la barra de menús desplegables) y después 
“Save as” (Figura 13), asignamos un nombre a nuestra matriz, en este caso “Red de 
amistad” y listo, ya que hemos almacenado la matriz en nuestra computadora podremos 
cerrar esta ventana. 

 

 
Figura 13. Almacenamiento de una matriz 

 
Para poder copiar o transferir los archivos que se generen en Ucinet ó para 

transportarlos a otras computadoras debemos copiar dos archivos, uno con extensión 
“.##h” y otro con “.##d”, porque si sólo se copia uno de los dos no se pueden visualizar las 
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gráfica o incluso no se pueden abrir, en nuestro ejemplo se tendrían que copiar los 
archivos: “Red de amistad.##h” y “Red de amistad.##d”. 

 
Cabe mencionar, que todo el procedimiento para realizar una matriz, puede también 

generarse en una hoja de cálculo de Microsoft Excel, este software se recomienda para 
matrices que contengan una cantidad considerable de nodos ya que Excel cuenta con 
herramientas que facilitan la captura, edición y la visualización de la información. Sólo se 
tiene que seleccionar la información, copiarla y pegarla en la “hoja de captura”. 

 
Hasta este momento, hemos completado la primer parte que compete a Ucinet: la 

preparación de una matriz y la captura de los datos en la misma. Proseguiremos con el 
siguiente paso: graficar nuestra matriz en un grafo8. 

 
 

Generación del gráfico de una Red con NetDraw 1.48 
 
El primer paso para poder analizar una Red, es construir un gráfico o grafo; para 

hacerlo, presionamos el segundo icono de derecha a izquierda ( ), en seguida 
nos aparecerá la pantalla de inicio de Netdraw, como la mostrada en la Figura 15 y 
presionamos “Ok”.  De la misma manera, este programa presenta características similares 
a los demás programas creados para el mismo Sistema Operativo (Windows); es decir, 
cuentan con una barra de menús, barra de iconos de acceso directo, ventanas flotantes, 
etcétera. 

Figura 14

Figura 14. Inicio de NetDraw 1.48 
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Figura 15. Ventana de inicio de NetDraw 1.48 

 
Para poder trabajar, será necesario abrir la matriz anteriormente creada y guardada, 

para conseguirlo presionamos el segundo icono de izquierda a derecha “open UCINET 
network dataset” (Figura 16), al presionar este icono el programa nos proporcionará un 
cuadro donde podremos buscar el nombre del archivo para abrir, presionamos el botón 
con “puntos suspensivos” y buscamos la carpeta en donde hayamos guardado la matriz  
“Red de amistad.##h”, lo seleccionamos, presionamos “abrir” (Figura 17) y por último “Ok”; 
inmediatamente, el programa hará una representación gráfica de la Red (Figura 18). 

 

 
Figura 16. Procedimiento para abrir la matriz guardada 

 
 

 
Figura 17. Procedimiento para seleccionar la matriz guardada 
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Figura 18. Representación gráfica de la Red de amistad 

 
La Figura 18 nos muestra la primera representación gráfica de nuestra Red, en 

algunas ocasiones, NetDraw nos proporciona un grafo que no es totalmente legible. Por 
ejemplo, en nuestra Red de amistad Beto referencia Gil pero en la Figura 18 no se 
observa esa relación debido a la posición de Alex dentro de la figura; una gran ventaja 
que nos ofrece este software es que podemos mover los nodos pulsando el botón 
izquierdo del “Mouse” sobre el nodo y arrastrarlo a la posición deseada ( ). Figura 19

Figura 19. Forma manual de acomodar los nodos de una Red 

 

 

 
En nuestra gráfica podemos observar los vínculos entre los nodos o actores (Alex, Gil, 

Rox, etc.), los diferentes flujos unidireccionales (de Alex hacia Pao, de Alexa hacia Gil, 
etc.), bidireccionales (entre Kiko y Beto, etc.); y también, a los nodos que no refieren a 
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nadie y que no son referidos por ningún actor (Vero, Prisci y Armando). Claramente 
vemos también que existen nodos mejor conectados que otros; y actores con pocas 
conexiones que aparecen en la periferia de la Red ( ). Figura 19

 
Ahora, para ver un gráfico que nos diferencie entre un nodo y otro, recurrimos a 

características atributivas (edad, sexo, carrera profesional, etc.), las cuales deberán ser 
capturadas de manera similar en la que creamos nuestra matriz pero siguiendo otro 
procedimiento que a continuación explicaremos. 

 
 

Introducción de características atributivas (Atributos de los 
nodos) 

 
Para poder introducir atributos9 a los nodos o actores, abriremos el “Spreadsheet” 

desde Ucinet (Figura 3 A); en este caso vamos a introducir el atributo “sexo”, una manera 
muy sencilla y práctica de hacerlo es volviendo a abrir la matriz (Red de amistad), 
presionando el menú desplegable File>Open. Posteriormente reduciremos el número de 
columnas “Cols:” a 1 (no así el número de filas, que deberá quedarse con el valor de 11) y 
eliminaremos los valores que pertenecen a la matriz; ahora el título de la columna será 
“sexo” e introduciremos el valor de “1” para los hombres y un valor de “2” para las 
mujeres, de manera que la nueva matriz se vea como en la Figura 20. 

 

 
Figura 20. Atributo “Sexo” para cada actor 

 
Por último, guardaremos el nuevo archivo desde “File>Save As”, ahora lo llamaremos 

“Red amistad (sexo)”; ya que hayamos nombrado y guardado nuestro archivo cerraremos 
la ventana. 

 

                                                 
9 Los atributos de un nodo son características que nos permiten identificar a cada actor o a grupos de actores y, de esta 
manera diferenciar unos de otros. 
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Con este atributo, ahora será más fácil poder visualizar la gráfica de la Red y nos 
permitirá generar conclusiones más exactas a nuestro primer análisis visual. 

 
 

Gráfica de la Red de amistad con atributos 
 
Una vez introducido el atributo o los atributos, todo dependerá de cómo queramos 

diferenciar a los nodos de la Red o a los grupos que la conforman; volveremos a NetDraw  
con el gráfico abierto (en ningún momento lo cerramos), presionamos el tercer icono de 
izquierda a derecha “Open UCINET attribute dataset” ( ); una vez más el 
programa abre una ventana que nos pide el nombre del archivo, presionamos el botón 
con los “puntos suspensivos”, localizamos la ruta en donde está almacenado el archivo 
“Red de amistad (sexo).##h”, lo seleccionamos, presionamos “abrir” y por último “Ok”; en 
seguida aparece en la pantalla un cuadro similar a lo presentado en la (Figura 22), lo cual 
indica que el atributo se ha cargado satisfactoriamente. 

Figura 21

Figura 21. Icono para abrir la ventana y agregar Atributos a la Red de amistad 

 

 

 
 

 
Figura 22. Cargando los atributos para la Red 

 
Ahora, para poder visualizar la Red con atributos, presionamos el cuarto icono de 

derecha a izquierda “Choose node colors according to attribute values” ( ), en 
seguida se abrirá una ventana flotante “Color nodes by attribute”. En donde aparece la 

Figura 23
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palabra “Select”, presionamos en la pestaña y buscamos el atributo “Red de amistad 
(sexo)”, lo seleccionamos y automáticamente veremos que los colores de los nodos 
habrán cambiado dependiendo del sexo de cada uno de los actores ( ). Figura 24

Figura 24. Cambio de color de los nodos por atributo 

 

  
Figura 23. Procedimiento para cambiar el color de los nodos por atributo 

 
 

 

 
Dentro de las posibilidades que ofrece NetDraw para poder visualizar los gráficos de 

redes, es cambiar el tipo de color de los nodos, esto se hace presionando el cuadro de 
color (rojo y azul en nuestro ejemplo) de los atributos y automáticamente el programa 
mostrará un panel de colores en donde podemos escoger el que más nos agrade. 
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Si deseamos darle otra presentación y una mejor diferenciación a nuestros nodos o 

actores, también podemos cambiar la figura del nodo dependiendo del atributo, para esto 
presionamos el tercer icono de derecha a izquierda “Choose node shape according to 
attribute values” ( ), de la misma manera se abrirá una nueva ventana “Shapes of 
nodes”, seleccionamos el atributo y presionamos “enter” y podremos ver que las figuras 
de los nodos han cambiado ( ). 

Figura 25

Figura 25. Procedimiento para cambiar la forma de los nodos por atributo 

Figura 26

Figura 26. Cambio de forma de los nodos por atributo 
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De manera similar, también podemos cambiar el tipo de forma que más nos agrade 
siguiendo el mismo procedimiento con el cual se puede cambiar el color, sólo que en este 
caso tenemos que bajar la “pestaña” de las formas disponibles y una vez seleccionada la 
que deseamos, presionar el botón con la “paloma” (junto de la “cruz”) y listo. 

 
Hay ocasiones en las cuales sea hace necesario tener guardado el gráfico de la Red, 

por ejemplo, para pegarlo en una presentación; para poder hacer esto (en NetDraw 1.48), 
la ruta es siguiente: File>Save Diagram As>Jpeg, el programa también ofrece la 
posibilidad de guardar el gráfico como BMP y/o como un Metaarchivo mejorado; nosotros 
recomendamos el Jpeg porque ocupa menos espacio en el disco duro y da buena 
resolución a las imágenes. 

 
Hasta ahora, sólo hemos realizado un análisis gráfico de la Red de amistad, lo cual 

nos puede llevar a hacer las primeras hipótesis acerca de su comportamiento y de cuáles 
son los nodos más importantes o centrales. Por ejemplo, se observa que Alex y Kiko son 
nodos que están mejor conectados ya que tienen el mayor número de vínculos a 
comparación de los demás; que la Red esta dispersa, ya que hay nodos que no tienen 
conexiones, que la mujeres dentro de esta Red no dicen tener relaciones entre ellas 
mismas y por tanto están más relacionadas con los hombres, además que Beto no dice 
tener relación con las mujeres dentro de la Red, etcétera. 

 
Para poder hacer aseveraciones más acertadas de las características de la Red y de 

cada uno de sus componentes; se tiene que recurrir al análisis de indicadores de redes, y 
de esta manera poder llegar a conclusiones más exactas. 

 
Existen indicadores que pueden realizarse de forma individual (para cada nodo) y de 

forma conjunta (para toda la Red), en el Cuadro 2 se muestra el tipo de indicador que 
veremos en este manual y su uso, ya sea individual o de forma conjunta. 

 
Cuadro 2. Tipo de indicadores  

Tipo de indicador Nodo Red 
completa Descripción 

Densidad Sí Sí 

Nos muestra el valor en porcentaje de la 
Densidad de la Red, es decir, nos muestra 
la alta o baja conectividad de la Red. La 
Densidad es una medida expresada en 
porcentaje del cociente entre el número de 
relaciones existentes con las posibles. 

Centralidad Si No 
El Grado de centralidad es el número de 
actores a los cuales un actor está 
directamente unido. 

Centralización No Sí 
Es una condición especial en la que un 
actor ejerce un papel claramente central al 
estar altamente conectado en la Red.  

Intermediación  Sí Sí 

Es la posibilidad que tiene un nodo para 
intermediar las comunicaciones entre pares 
de nodos. Estos nodos son también 
conocidos como actores puente. 

Cercanía  Sí Sí Es la capacidad de un actor para alcanzar 
a todos los nodos de la Red. 
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Indicadores de Redes 
 
Densidad (Density) 
 

La Densidad de una Red puede calcularse sin necesidad de usar el software, este se 
calcula dividiendo el número de relaciones existentes entre las posibles y multiplicado por 
100. En nuestro ejemplo tenemos 18 relaciones de 110 que pudieran existir; es decir, una 
Densidad de 18 / 110 x 100 = 16.36 % de toda la Red. El cálculo del total de relaciones 
posibles se hace multiplicando el número total de nodos por el número total de nodos 
menos uno, en nuestro ejemplo: 11 x (11-1) = 11 x 10 = 110.  

 
Ahora, si calculáramos la Densidad de Gil, tenemos: 7 relaciones existentes de 70 

posibles (tanto de entrada como de salida), por lo tanto 7 / 70 x 100 = 10 %. 
 
Ya que hemos calculado la Densidad de la Red y que conocemos la alta o baja 

conectividad de la misma, procederemos a calcular nuestro siguiente indicador el cual nos 
mostrará la cantidad de conexiones que cada actor posee.  
 
Grado de centralidad (Centrality degree) 

 
El Grado de centralidad es el número de actores a los cuales un actor está 

directamente unido. El Grado de centralidad se divide en grado de entrada y grado de 
salida, podemos observar en nuestra Red que estos Grados de entrada y de salida 
dependen de la dirección del flujo; así tenemos que: 
 

 El grado de salida: es la suma de las relaciones que los actores dicen tener con 
el resto. Por ejemplo, Gil dice tener relación de amistad con Alex, Karla y Kiko, por 
lo cual su grado de salida es de 3 (Figura 27 A). 

 
 El grado de entrada: es la suma de las relaciones referidas hacia un actor por 

otros. Para el mismo ejemplo, Gil es mencionado por 4 personas (Alex, Kiko, Beto 
y Alexa), por lo tanto su grado de entrada es de 4 (  B). Figura 27

Figura 27. Grado de entrada y de salida de la Red de amistad de Gil 

 

A) Grado de salida 
 

 B) Grado de entrada 
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Si quisiéramos que el software (Ucinet) calculara para cada nodo su Grado de 
centralidad (de entrada y de salida), el procedimiento es el siguiente: 

 
1. En la barra de menús seguimos la ruta Network>Centrality>Degree (Figura 28 A). 

 
2. En la ventana que aparece abrimos “Red de amistad” como en los casos 

anteriores y presionamos “abrir”. 
 

3. En la celda “Treat data as symmetric” cambiamos el “Yes” por “No”, recordemos 
que estamos trabajando con una Red asimétrica; es decir, si A refiere a B no 
necesariamente B tiene que referir a A (Figura 28 B). 

 
4. Presionamos “Ok” e inmediatamente se abrirá una nueva ventana con los 

indicadores deseados (  C). Figura 28

Figura 28. Grado de centralidad (Entrada y Salida) de la Red de amistad 

 
5. Estos indicadores podemos copiarlos “Edit>Copy” y/o guardarlos “File>Save As” 

entre otras opciones (Figura 28 D). 
 

 

 
A) Ruta del Grado de centralidad 

 
B) Opciones del Grado de centralidad 

 

 
C) Medidas del Grado de centralidad para cada 

uno de los actores de la Red 
D) Guardar Cómo, la salida del indicador 
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En los resultados mostrados por Ucinet, podemos observar a nuestros actores 
ordenados de mayor a menor por su Grado de centralidad, tenemos también que existen 
4 columnas (Cuadro 3). 

 
Cuadro 3. Significado de las columnas en el análisis de centralidad 

Nombre de columna Significado 
1 OutDegree Grado de salida 
2 InDegree Grado de entrada 
3 NrmOutDeg Grado de salida normalizado 
4 NrmInDeg Grado de entrada normalizado 

 
Cuadro 4. Resultados de centralidad para cada actor 

Cuadro 4

 
 
Los resultados del  muestran el grado de entrada y de salida de todos los 

nodos en las últimas dos columnas, el grado de salida y entrada normalizados son la 
representación porcentual de dichos grados, de esta manera, podemos afirmar que el 
actor central de nuestra Red de amistad en cuanto a menciones recibidas es Alex, ya que 
tiene un grado de entrada de 5, y grado de entrada normalizado del 50 %. 

 
También nos encontramos, dentro del análisis de Grado de centralidad que muestra 

Ucinet, algunos indicadores generales (de toda la Red), nombrados como DESCRIPTIVE 
STATISTICS ( ), donde podemos observar la media (Mean) de todas las 
relaciones, en nuestro caso la media es de 1.636, lo cual nos habla de un número muy 
bajo de menciones en toda la Red; sin embargo, debemos recordar que tenemos a 3 
nodos sueltos y dos que no hacen referencia a nadie. Continuamos con la desviación 
estándar (Std Dev),  que no es otra cosa más que la variación de la media, podemos 
observar que en nuestro ejemplo la desviación estándar se encuentra muy cerca de la 
media, lo cual nos indica que existe una alta dispersión. La suma (Sum), como su nombre 
lo dice, es la suma de todas las relaciones, nuestro ejemplo consta entonces de 18 
relaciones. 

Cuadro 5

 
Podemos ver, en seguida de la suma, otros indicadores que a nuestro criterio no son 

por el momento de mucha importancia, exceptuando el Mínimo (Minimum) y el Máximo 
(Maximum) lo cuales nos indican el grado máximo y mínimo que tienen los actores dentro 
de la Red  
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Cuadro 5. Estadísticas descriptivas generales del Grado de centralidad  

 
 
Dentro de los resultados mostrados por Ucinet, en el momento de calcular el Grado de 

centralidad, tenemos otro indicador; el cual es de gran utilidad en la interpretación y 
análisis de una Red, este indicador se describe a continuación. 

 
 

Índice de centralización (Centralization index) 
 
Es una condición especial en la que un actor ejerce un papel claramente central al 

estar conectado con todos los nodos, los cuales necesitan pasar por el nodo central para 
conectarse con otros. Para ejemplificar mejor el Grado de centralización usaremos un 
ejemplo diferente: donde el Productor1 es el único con Grado de entrada o de salida igual 
a “1” (Grado de centralización = 100 %), este tipo de redes indican que existen actores 
mucho más centrales (Productor1) que otros y se asemeja al comportamiento de una Red 
estrella (  A). Por otro lado, todo lo contrario a la Red estrella serían valores bajos 
en este indicador, lo cual indicaría ausencia de actores claramente centrales (  
B). 

Figura 29
Figura 29

Figura 29. Grado de centralización 

 

 
A) Red Estrella, Grado de centralización = 100 % 

 
B) Grado de centralización = 0 % 

 
Cabe aclarar que dentro del análisis de redes existen Grados de centralización de 

entrada y de salida; el uso de uno u otro dependerá de la necesidad de resultados 
específicos de cada Red.  
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Volviendo al ejemplo de nuestra Red de amistad, los Grados de centralización de 
entrada y de salida se obtienen calculando el Grado de centralidad (Figura 28). Dentro de 
la ventana del reporte, en la parte inferior se observa el Grado de centralización de 
entrada y de salida de la Red. 

 

 
 
El Grado de centralización de una Red, ya sea el de entrada o el de salida, indica qué 

tan cerca esta la Red de comportarse como una Red Estrella, en donde un actor juega un 
papel central que controla a toda la Red; o qué tan lejos está de ese comportamiento, el 
cual es más favorable debido a que esto nos habla de una Red bien conectada. 

 
Ya que hemos identificado a los actores centrales, procederemos a encontrar a los 

nodos que pueden conectar a los demás a través del cálculo del siguiente indicador. 
 
 

Grado de intermediación (Betweenness) 
 
Una razón para considerar la importancia de un actor recae en su intermediación, esta 

se enfoca en el “control de la comunicación”, y se interpreta como la posibilidad que tiene 
un nodo o actor para intermediar las comunicaciones entre pares de nodos.  

 
En este análisis se consideran todos los posibles caminos geodésicos10 entre todos 

los pares posibles. La medida de intermediación de un nodo se obtiene al contar las veces 
que este aparece en los caminos (geodésicos) que conectan a todos los pares de nodos 
de la Red, a estos actores les llamaremos actores puente. 

 
Así, para poder explicar mejor la intermediación, usaremos otro ejemplo, nuestro 

nuevo ejemplo (Figura 30), contiene 6 nodos (tamaño de la Red), en donde el nodo A 
aparece en todos los caminos posibles para que los demás nodos puedan conectarse (de 
F a B, F a C, F a D, F a E, B a C, B a D. B a E, C a D, C a E y, D a E); por tanto, este 
actor tiene un Grado de intermediación de “10”, mientras que los otros actores tienen un 
Grado de intermediación de “0”. 

 
Es necesario remarcar que para que un nodo tenga Grado de intermediación en una 

Red por lo menos este debe tener un Grado de entrada y de salida y; además, estar en el 
o los caminos geodésicos entre los pares de nodos que se quieren conectar. 

                                                 
10 Los caminos geodésicos son las rutas más cortas que un actor debe  seguir para llegar a otros nodos. 
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Figura 30. Grado de intermediación del nodo A 

 
Ahora, si nosotros tuviéramos una Red donde cada actor hace referencia a uno de sus 

compañeros como en la Figura 31, tendríamos una Red donde cada nodo tiene un Grado 
de intermediación de “10” ya que para un nodo pueda llegar a otro con el cual no esta 
conectado directamente, tendría que utilizar a otros como “puente” para poder 
alcanzarlos. Por ejemplo, si el nodo A quiere conectarse con el nodo D, E y/o F (con los 
cuales no está conectado directamente) tendría que pasar o utilizar como “actor puente” a 
el nodo B. forzosamente ( ). Figura 31

Figura 31. Ejemplo de una Red de 6 nodos para calcular su Grado de intermediación 

 

 

 
Ya que hemos entendido el funcionamiento del Grado de intermediación, trataremos 

de obtenerlo para cada uno de los actores en el ejemplo de la  con la ayuda de 
la información del Cuadro 6. 

Figura 32

 

Medidas de Centralidad 26



Manual Introductorio al Análisis de Redes Sociales 

 
Cuadro 6. Intermediación entre nodos 

Nodo Es “puente” para relacionar a: 
A Nadie 
B (A y C), (A y D), (A y E), (E y C), (D y C) 
C (B y D) 
D Nadie 
E (C y A), (C y B), (B y D), (D y A), (D y B), (D y C),  

 

 
Figura 32. Ejemplo de una Red de 5 nodos para calcular su Grado de intermediación 

Figura 32

 
Podemos observar que los nodos A y D no son actores puente para conectar a los 

nodos B, C y E en la Red ya que éstos pueden conectarse a los demás nodos sin ayuda 
de A y D. El nodo E es quien tiene el mayor Grado de intermediación (6) ya que sirve de 
puente para conectar a seis pares de nodos dentro de la Red, el nodo B tiene un Grado 
de intermediación de “5”, siendo este el segundo actor más fuerte para intermediar 
comunicaciones entre los demás nodos y; por último, tenemos que el nodo C sólo sirve 
para intermediar la relación entre el nodo B y el nodo D, obteniendo así un Grado de 
intermediación de “1”. 

 
Si observamos detenidamente la , encontraremos que el actor con mayor 

Grado de intermediación (E), es también el actor con el mayor Grado de centralidad con 
un grado de entrada de 3; así, podemos afirmar que el actor E es el nodo central de este 
ejemplo. 

 
Volviendo a nuestro primer ejemplo: “Red de Amistad” realizaremos el análisis de 

intermediación, con la ayuda de Ucinet a partir del siguiente procedimiento: 
 
1. En la barra de menús seguimos la ruta Network>Centrality>Betweenness>Node 

(Figura 33)  
 

2. En la ventana que aparece seleccionamos el nombre del archivo “Red de Amistad” 
y presionamos “abrir”. 

 
3. Presionamos “Ok” e inmediatamente se abrirá una nueva ventana con los 

indicadores deseados ( ). Figura 34
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4. Estos indicadores podemos copiarlos “Edit>Copy” y/o guardarlos “File>Save As”  
 

 
Figura 33. Procedimiento para generar el Grado de intermediación 

 
 

 
Figura 34. Resultados del análisis del Grado de intermediación 

 
Podemos observar en nuestro primer ejemplo, que los resultados de intermediación 

nos arrojan a Alex como el actor de mayor intermediación con 9.667, Gil con una 
intermediación de 5.500 y Kiko, Rox y Beto con grados menores, también podemos 
observar que los demás actores tienen una intermediación de “0”, esto se debe a que 
como en el ejemplo anterior, no hay una dependencia de los demás actores para llegar a 
los otros nodos. 

 
Como podemos observar en el Cuadro 7, existen dos tipos de Grado de 

intermediación; hasta ahora, hemos visto el Grado de intermediación con números totales 
(1 Betwweenness); es decir el número de pares de nodos que un actor es capaz de 
conectar. La segunda columna de los resultados nos muestra el Grado de intermediación 
normalizado11 (2 nBetweenness), este indicador nos muestra el Grado de intermediación 
expresado en porcentajes; así, tenemos que el Grado de intermediación normalizado de 
Alex es de 10.74 %, mientras que Gil y Kiko tienen un grado normalizado de 6.1 % y 
2.96% respectivamente. 
                                                 
11 Expresión porcentual del grado. 
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Cuadro 7. Grado de intermediación de los nodos 

 
 
Nuevamente, Ucinet nos muestra las Estadísticas Descriptivas del Grado de 

intermediación (Cuadro 8), estos indicadores generales se interpretarán de la misma 
manera en que interpretamos los indicadores de centralidad, pero siempre teniendo en 
mente, que estos valores son de intermediación. 

 
Cuadro 8. Estadísticas descriptivas generales del Grado de intermediación 

 
 
Quizás el lector, se este preguntando: ¿Por qué la mayoría de los actores tienen 

Grado de intermediación con fracciones como son 9.667, 5.500, 2.667, etc.? Para poder 
dar respuesta a esta pregunta presentamos el ejemplo de la  en donde, como se 
puede observar, tanto el nodo B como el C y el E están fungiendo como intermediarios 
para que el nodo A y D se puedan conectar. Ahora, si contamos los caminos geodésicos 
que hay entre A y D son 3 los posibles (A-B-D, A-C-D y, A-E-D) y en cada uno de ellos 
está involucrado un nodo específico; por lo tanto, si dividimos las veces en las que 
participa cada nodo en los caminos geodésicos entre el total de los caminos geodésicos 
posibles, tendríamos: 1/3 = 0.333; siendo este valor el Grado de intermediación de los 
nodos B, C y, E. 

Figura 35
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Figura 35. Ejemplo de una Red de 5 nodos con 6 vínculos 

 
Para una Red más compleja y para que el lector comprenda de una manera más 

adecuada cuando el Grado de intermediación esta formado por fracciones, se presenta el 
ejemplo de la Figura 36; en donde el Grado de intermediación de cada nodo se presenta 
en el Cuadro 9. 

 

 
Figura 36. Ejemplo de una Red de 5 nodos con 9 vínculos 

 
Cuadro 9. Grado de intermediación de los nodos de la Figura 36 

 
 
En este caso, para calcular el Grado de intermediación del nodo B observamos que 

existen 3 caminos geodésicos entre los nodos A y D, el nodo B participa en uno de ellos 
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por tanto: 1/3 = 0.333; entre el nodo A y F sólo hay un camino y B participa en él (1/1 = 1) 
y por último, entre los nodos C y F hay dos caminos geodésicos y B participa en uno de 
ellos así: (1/2 = 0.5) sumando 0.333 + 1 + 0.5 tenemos el 1.833 el cual es el Grado de 
intermediación del nodo B. Los mismos cálculos se hacen para los demás nodos y el 
lector puede hacerlo para corroborar que sí son los valores que muestra Ucinet. 

 
Ya que hemos calculado y comprendido el Grado de intermediación, sólo nos resta 

calcular otro indicador que es muy interesante y de gran ayuda en el análisis e 
interpretación de una Red, este indicador es el Grado de cercanía. 
 
Grado de cercanía (Closenness)  
 

El Grado de cercanía es la capacidad de un nodo de llegar a todos los actores de una 
Red, este se calcula al contar todas las distancias geodésicas de un actor para llegar a los 
demás, cabe destacar que este método sólo podemos utilizarlo en matrices simétricas12 
en el Cuadro 10, se muestra la forma más sencilla de calcular este indicador, como 
ejemplo tendremos una Red de 11 actores y las distancias geodésicas de cada uno de 
ellos. 

 
Cuadro 10. Cálculo de cercanía de una Red simetrizada 
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Jaime Mendoza  3 2 1 1 2 2 2 2 1 3 19 52.6 

Emiliano Aguilar 3  2 4 4 3 2 2 1 2 1 24 41.7 

Rafael Amezcua 2 2  2 3 1 1 2 1 1 1 16 62.5 

Alberto Madrigal 1 4 2  2 1 2 3 3 2 3 23 43.5 

Silverio Vázquez 1 4 3 2  3 3 3 3 2 4 28 35.7 

Honorio Virrueta 2 3 1 1 3  1 3 2 2 2 20 50.0 

Agustín Gaona 2 2 1 2 3 1  2 1 1 1 16 62.5 

Sergio Ochoa 2 2 2 3 3 3 2  2 1 1 21 47.6 

Agustín Estebes 2 1 1 3 3 2 1 2  1 1 17 58.8 

Enrique Morelos 1 2 1 2 2 2 1 1 1  2 15 66.7 

José Bejar 3 1 1 3 4 2 1 1 1 2  19 52.6 
  
 
 
 

                                                 
12 Matriz donde las relaciones entre los nodos se dan de manera bidireccional. 
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Figura 38. Procedimiento para obtener el Grado de cercanía 

 

 
Figura 39. Resultados del Grado de cercanía de la Red de Amistad por nodo 

Figura 39
 

Los resultados obtenidos  en la  nos muestran dos tipos de cercanía 
(inClosenness y outClosenness) estas se refieren al Grado de cercanía de entrada y de 
salida; nosotros tomaremos el Grado de entrada como referencia principal, así, tenemos 
que Alex es quien posee el mayor Grado de cercanía con un valor 18.182, los nodos 
sueltos (Prisci, Vero, Armando) así como Alexa poseen el Grado de cercanía más bajo al 
reportar todos ellos un grado de 9.091 (Cuadro 11) 
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Cuadro 11. Resultados del Grado de cercanía de la Red de Amistad por nodo. 

 
 
Cuadro 12. Estadísticas descriptivas generales del Grado de cercanía 

Cuadro 12

 
 

En este indicador también Ucinet nos muestra las Estadísticas Descriptivas del Grado 
de cercanía ( ), estos indicadores generales se interpretarán de la misma 
manera en que interpretamos los indicadores de centralidad y de intermediación, pero 
siempre tomando en cuenta, que estos valores son de cercanía. 
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Generación de Redes y Atributos múltiples 

 
Generación de Redes múltiples 

 
Existen ocasiones en las cuales se requiere analizar diferentes redes puesto que el 

análisis lo requiere así o simplemente, para comparar el comportamiento que tiene cada 
una de ellas. Por ejemplo, hay veces en las que un grupo de personas entablan 
relaciones de diferente índole como son: redes de gestión, redes de comercialización, 
redes sociales, redes de innovación tecnológica, etc., es en estos casos en donde por lo 
general se comparan las diferentes redes. 

 
Lo primero que se pensaría para poder hacer este análisis, sería generar un archivo 

por cada Red como ya lo hemos visto y a cada una asignarle atributos diferentes con la 
consiguiente generación de más archivos. 

 
Para poder hacer esto de una manera más sencilla, Ucinet nos permite insertar “hojas 

de captura” nuevas. Este procedimiento se hace de la siguiente manera: 
 
1. Una vez que estamos en la “hoja de captura (spreadsheet)”, abrimos el archivo 

que ya habíamos generado anteriormente (Red de amistad). 
 
2. Posteriormente, seguimos esta ruta: Edit>Insert sheet ( ). Figura 40

 
Figura 40. Procedimiento para insertar una 

nueva “hoja de captura” 
 

Figura 41. Asignación del nombre a la nueva 
“hoja de captura” 

 

 
3. Inmediatamente, el programa nos pedirá un nombre para la hoja, en este caso 

introduciremos el nombre de “Red 2” (Figura 41). 
 

4. Para poder diferenciar una Red de la otra, cambiaremos el nombre de la primera 
“hoja de captura”, lo que hay que hacer en primer lugar es posicionarnos en dicha 
hoja, posteriormente seguir esta ruta: Edit>Rename sheet (Figura 42). 

 
5. Al abrirse la ventana en donde se nos pide el nuevo nombre de la “hoja de 

captura” asignamos el de “Red 1” (Figura 43). 
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Figura 42. Procedimiento para cambiar el 

nombre a una “hoja de captura” 
Figura 43. Asignación del nuevo nombre a la 

“hoja de captura” 
 
Ahora, para poder generar otra Red la cual podamos introducir en la nueva “hoja de 

captura” y siguiendo el mismo ejemplo de la “Red de amistad” vamos a suponer que 
después de haber pasado un tiempo, se les vuelve a preguntar a las mismas personas 
¿con quién tiene relaciones de amistad? Quizás algunos se mantengan con sus mismas 
relaciones, otros pueden tener nuevas amistades, o quizás algunos hayan roto sus 
relaciones que anteriormente tenían; de esta manera, en el  se presentan los 
resultados de las nuevas relaciones de amistad que los actores dijeron tener entre ellos. 

Cuadro 13

Cuadro 13. Resultados de las nuevas relaciones de amistad entre los actores 
 

Nombre Tiene amistad con 
Alex Gil, Rox, Pao y Armando 
Gil Alex, Karla y Kiko 
Rox Beto, Kiko, Pao y Vero 
Beto Alex, Gil y Kiko 
Vero Armando y Kiko 
Pao Karla y Kiko 
Karla Vero, Armando y Rox 
Prisci Alex y Kiko 
Armando No tiene 
Alexa Alex, Kiko y Beto 
Kiko Gil, Beto y Armando 
 
Por lo tanto, al introducir estos resultados en la “hoja de captura”, siguiendo el mismo 

procedimiento visto anteriormente, tendríamos nuestra matriz como la presentada en la 
(Figura 44), posteriormente sólo rellenamos con ceros (presionando el icono “Fill”) y 
guardamos las modificaciones con cualquier de los siguientes métodos: 

 
1. Simplemente presionamos Ctrl. + S. 
2. Presionamos el tercer icono, de izquierda a derecha. 
3. O seguimos esta ruta: File>Save 
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Figura 44. Llenado de la nueva matriz 

 
En este caso ya no es necesario volver a generar un nuevo archivo pues ya lo 

teníamos (Red de amistad), posteriormente cerramos la ventana y podemos empezar a 
graficar la nueva Red, pero primero veamos cómo introducir múltiples atributos para que 
de esta manera podamos hacer gráficos más interesantes. 

 
 

Generación de Atributos múltiples 
 
Para poder hacer esto, el procedimiento a seguir es: 
 
1. Primero abrimos el archivo en el cual ya habíamos introducido el atributo de “sexo” 

(Red de amistad (sexo)); podríamos crear uno nuevo cuando aún no se tenga 
ningún archivo generado con anterioridad, en nuestro caso utilizaremos el mismo. 

 
2. Una vez abierto el archivo, en la casilla de “cols” agregamos una columna más por 

cada atributo que vayamos a agregar, en este caso ponemos el número dos 
porque sólo vamos a introducir un nuevo atributo (pero se pueden agregar muchos 
más). Automáticamente vemos que aparece una columna vacía junto a la que ya 
teníamos (Figura 45). 

 
3. Con la información del  hacemos grupos de edades de la siguiente 

manera: el grupo 1 comprende las edades de 20 a 24 años, el grupo 2 de 25 a 29 
años y, el grupo 3 mayores a 30 años. De esta manera, asignamos el atributo 
edad a cada uno de los actores ( ). 

Cuadro 14

Figura 46
 

4. Guardamos las modificaciones siguiendo el procedimiento ya visto y listo. 
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Figura 45. Procedimiento para agregar una 

nueva columna para atributos 
Figura 46. Asignación del atributo “edad” a 

cada actor 
 

Cuadro 14. Edades de los actores 
Nombre Edad 

Alex 23 
Gil 22 
Rox 26 
Beto 28 
Vero 20 
Pao 30 
Karla 28 
Prisci 25 
Armando 30 
Alexa 32 
Kiko 21 

 
Ya que tenemos tanto el archivo con las redes y otro con el de atributos, podemos 

pasar a la generación de los gráficos y posteriormente al análisis de las redes con los 
indicadores. 

 
 

Generación de gráficos con Redes y Atributos múltiples 
 
Para poder hacer este tipo de gráficos, primero tenemos que abrir NetDraw 1.48 como 

ya lo hemos visto, posteriormente abrimos el archivo “Red de amistad” y automáticamente 
el programa nos presentará un gráfico que nos resultará familiar porque ya lo hemos visto, 
para poder tener otra vista del gráfico presionamos el décimo icono contando de izquierda 
a derecha (Figura 47), también se pueden utilizar los siguientes cinco iconos para 
visualizar de diferentes formas el gráfico, la elección de uno o de otro dependerá del 
lector. En nuestro caso seleccionaremos la “disposición en círculo”. 

 
Inmediatamente la forma del gráfico cambia, la presentación ahora es diferente 

(Figura 48), con esta forma del gráfico se nos facilitará más la observación del mismo 
para lo que a continuación se va a hacer. 
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Figura 47. Icono para generar diferentes 

vistas del gráfico 
Figura 48. Nueva visualización del gráfico 

 
Como podemos observar en la  existen diferentes ventanas flotantes junto 

del gráfico, por el momento la que más interesa es la que cuyo encabezado es “Ties 
(relaciones)”, para poder visualizar la otra Red que habíamos creado, tenemos que bajar 
la “pestaña” en donde inicialmente dice “Red 1” ( ) y después seleccionamos 
“Red 2”. 

Figura 49

Figura 49

Figura 49. Selección de la nueva Red para la generación del gráfico 

 

 

 
Inmediatamente, el gráfico cambia; los vínculos y los flujos ahora son diferentes y 

todos lo nodos están conectados (Figura 50); es decir, ya no hay nodos sueltos como en 
la “Red 1”, también podemos observar que en la “pestaña” aparece ahora el nombre de 
“Red 2” por lo tanto si queremos regresar a la “Red 1” sólo tenemos que seleccionarla 
siguiendo el mismo procedimiento. 
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Figura 50. Gráfico nuevo, Red 2 

 
Para poder visualizar el gráfico de la Red con los Atributos creados, seguimos el 

procedimiento que ya habíamos visto y; de la misma manera, podemos diferenciarlos por 
color y por la forma de la figura ( ). Figura 51

Figura 51. Diferenciación de los nodos por color y forma de la figura con el uso de Atributos 

 

 

 
La ventaja de tener múltiples Atributos es que podemos diferenciar a los actores o 

grupos de actores utilizando un color para un Atributo y la forma de la figura para otro 
Atributo ( ). Figura 52
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Figura 52. Diferenciación de los nodos utilizando dos atributos 

 
 

Indicadores de Redes múltiples 
 
Para poder obtener los indicadores de cada una de las Redes, procedemos de la 

misma manera antes vista, la única diferencia es la forma en la que se presentan los 
resultados. 

 
De esta manera, tenemos que para el Grado de centralidad 

(Network>Centrality>Degree) la forma en que se presentan los resultados es como la 
, en donde podemos observar que el programa primero muestra los resultados 

de la “Red 1” y posteriormente la de la “Red 2”; cada una con sus “Estadísticos 
descriptivos”, mismos que se interpretan de la misma manera como ya hemos visto. 
También podemos observar el Grado de centralización del cada una de las Redes. 

Figura 53

Figura 53. Grado de centralidad para Redes múltiples 
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Desafortunadamente para el Grado de intermediación y el de Cercanía, no se puede 

visualizar de la misma manera que el Grado de centralidad, ya que el programa sólo 
muestra la primer “hoja de captura” del archivo; es decir, en este caso, sólo presenta los 
resultados de la “Red 1”. Por lo que si se desean obtener estos indicadores, forzosamente 
se tendrían que separa las Redes en archivos diferentes. Para ejemplificar esto, se 
presenta la  en donde podemos observar una leyenda que especifica lo que ya 
hemos dicho. 

Figura 54

Figura 54. Grado de intermediación para Redes múltiples 

 

 

 
Ya que hemos comprendido la creación de una matriz, la realización de un gráfico, la 

captura y comprensión de los atributos de cada nodo para facilitar la interpretación de la 
Red y la generación de indicadores, ya sea para una sola Red con uno o varios atributos 
o incluso para manejar múltiples Redes, estamos preparados para hacer un Análisis de 
Redes Sociales con un mayor número de nodos manejando diversos atributos e 
indicadores que nos lleven a la comprensión de cualquier grupo social 
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Glosario de términos y conceptos 
 
 

Red 
Grupo de individuos que, en forma agrupada o individual, se 
relacionan con otros con un fin específico. Las redes pueden 
tener muchos o pocos actores y una o más clases de 
relaciones entre pares de actores.  

Grafo Nombre técnico del gráfico de una Red. 

Nodos o actores  
Los nodos o actores son las personas o grupos de personas 
que se encuentran en torno a un objetivo común. Usualmente 
los nodos o actores se representan por círculos. 

Tamaño de la Red La suma de todos los nodos o actores representa el tamaño 
de la Red. 

Vínculo Los vínculos son los lazos que existen entre dos o más nodos. 
Los vínculos o relaciones se representan con líneas. 

Flujo El flujo indica la dirección del vínculo. Los flujos se 
representan por una flecha que indica el sentido del flujo. 

Flujos mutuos o 
bidireccionales Son los flujos que contienen flechas en ambos sentidos. 

Flujos dirigidos o 
unidireccionales Flujo cuya dirección sólo contiene un sentido. 

Nodo suelto Nodo o actor que no tiene ningún tipo de flujo, lo que a su vez 
implica ausencia de vínculos. 

Matriz Conjunto rectangular de elementos dispuestos en líneas 
horizontales (filas) y verticales (columnas). 

Matriz cuadrada Matriz que contiene el mismo número de filas y de columnas 

Matriz simétrica Matriz donde las relaciones entre los nodos se dan de manera 
bidireccional. 

Matriz idéntica Matriz que contiene el mismo nombre y número de actores 
tanto en filas como en columnas 
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Ucinet 

Programa comprensivo para el análisis de redes sociales y 
otros atributos. El programa contiene docenas de rutinas 
analíticas para redes. Permite el análisis general y 
multivariado, contiene herramientas para crear escalas 
multidimensionales, análisis de correspondencia, análisis de 
factores, análisis de grupos y regresión múltiple. Además, 
UCINET provee una plataforma para el manejo de datos y 
herramientas de transformación para realizar procedimientos 
de teoremas gráficos con un lenguaje algebraico interpuesto 
por matrices. 

NetDraw 
 

Programa utilizado para graficar redes sociales. Usa 
diferentes tipos de algoritmos para generar gráficos en 
segunda y tercera dimensión. Netdraw es capaz de leer 
archivos generados por Ucinet. Los gráficos que genera 
pueden ser guardados en diversos formatos (BMP, WMF, 
JPG). 

Atributos 
Características de los nodos, las cuales permiten identificar a 
cada actor o grupo de actores dentro de una Red, ejemplo: 
edad, sexo, carrera profesional, etcétera. 

Caminos geodésicos Distancia (# de vínculos) entre un nodo y otro. 
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